
 

Guide for educators writing Electronic Transition Statements in 2017 

Reduced functionality version - Suitable for pre 2007 Microsoft Word 

This guide is for educators in early childhood education and care (ECEC) services completing 

Electronic Transition Learning and Development Statements (Electronic Transition Statements) in 

2017.  

Further guidance about how to complete Transition Statements, including supporting children and 

families to complete their sections of the Statement, is provided in the Transition: A Positive Start to 

School Resource Kit available at www.education.vic.gov.au/transitiontoschool. 
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Before you begin using the Electronic Transition Statement 
Before you begin to use the Electronic Transition Statement, please note and/or check the following: 

 Accessing the Electronic Transition Statement: The Electronic Transition Statement can be 

found at www.education.vic.gov.au/transitionstatement. In order to edit the Electronic 

Transition Statement, you will need to download/save a copy to your computer. Do this by 

opening the file you want to download, then go to the File menu and select ‘Save As’, and select 

where you want to save it and what you want to name the file.  

 

 IT System Requirements: The Electronic Transition Statement has been designed to enable 

completion on a computer. There are two Electronic Transition Statements to choose from: 

o Electronic Transition Statement - Full functionality for Word 2007 (or later) 

o Electronic Transition Statement - Reduced functionality (for pre 2007 Microsoft Word) 

Microsoft Word is required to complete the Electronic Transition Statement. Check your 

Start/Windows menu on your PC, or via the Apple icon on your Apple Macintosh to see whether 

Word is installed and which version/year it is to determine which Electronic Transition 

Statement to use. 

 Follow the prompts/instructional text: The Electronic Transition Statement has prompts and 

instructional text to guide you through completing each section. The document has been 

protected to restrict editing to the required fields, to make it easier for users to know where 

they need to provide a response. 

 

 Printing/Scanning documents: You may need to print, scan and upload documents to your 

computer. If you are unsure how to do this, or do not have the facilities, please make 

arrangements for someone to support you with this task. 

 

 Attaching photos: You have the option to insert a photo of a child to their Electronic Transition 

Statement. It will save you time if these photos are already saved onto your computer and easily 

accessible.  

 

 File naming conventions: It is important to ensure you have a consistent file naming convention 

for your Electronic Transition Statements. This is to ensure that personal information related to 

a particular child is protected, meets privacy obligations, and assists document retention. When 

first downloading the Electronic Transition Statement, it is recommended to rename the file 

‘2017 Electronic Transition Statement – Template’. Each individual Transition Statement can 

then be saved as ‘2017 Transition Statement – Child’s name’.  

 

 Troubleshooting: This User Guide contains instructions on common processes like downloading, 

completing, and saving your Electronic Transition Statement, plus detail on the functionality of 

the Electronic Transition Statement. Please read this Guide and follow the steps before 

requesting further assistance.  

 

Further IT support is available via State Library Victoria:   

Phone: 03 8664 7001       Toll Free: 1800 629 835      support@kindergarten.vic.gov.au 

http://www.education.vic.gov.au/transitionstatement
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Overview of the Electronic Transition Statement 
The table below describes each section of the Electronic Transition Statement and who should 

complete it. 

Section Information collected To be completed by 

Section 1: Child and 
Service Details 

 The child’s details (name, date of birth etc.), 
parent/guardian details and ECEC service 
details.  

 Contextual information about the ECEC service 
and specific information related to the child 
that may be useful for prep teachers to know 
or may impact on the child’s continuity of 
learning.  

ECEC educator* 

Section 1.1 – 
Outcomes and 
Teaching Strategies 

Descriptions of the child’s learning progress against 
the VEYLDF Learning and Development Outcomes 
and the Victorian Curriculum F-2, and specific 
intentional teaching strategies to support the 
child’s continuity of learning when they start 
school. 

ECEC educator* 

Section 1.2 –  
Enhanced Transitions 
for children with a 
disability or 
developmental delay 

This section should be completed for children with 
a disability or developmental delay. It collects 
additional specific information to support the 
child’s inclusion and learning at school. 

ECEC educator* (in 

collaboration with other 
professional/s supporting the 
child, where applicable, and 
with parent/guardian 
permission) 

Section 2 – The child The child’s feelings and perspectives on starting 
school, including a drawing. This section is 
optional. 

Completed with the 
child by an adult they 
know and feel 
comfortable with 
(educator or family 
member)** 

Section 3 – The 
family 

The perspective of the parent/guardian(s) on their 
child’s transition to school, and other information 
they would like to share. 

Parent/guardian(s)** 

Section 4 – Sharing 
the Transition 
Statement 

 A declaration from the educator that the 
child’s parent/guardian is aware that the 
Transition Statement will be shared with their 
child’s school and OSHC service (where 
applicable) 

 A declaration from the educator that the 
child’s parent/guardian has received the 
completed Transition Statement  

 A record of whether the parent/guardian has 
chosen to opt out of sharing the Transition 
Statement with the school and OSHC service (if 
applicable). 

ECEC educator* 

*ECEC educators should write Transition Statements in discussion and with input from families, and from other 

professionals who may be supporting the child during the transition to school (with permission from the parent/guardian).  

** Families for whom English is an additional language may require assistance from the educator and/or an 

interpreter/translator to complete the Child and Family sections, and to understand their choice to opt out of sharing the 

Transition Statement information. 
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USING THE ELECTRONIC TRANSITION STATEMENT 

How to download the Electronic Transition Statement 

Before you start writing Transition Statements, you will need to download the Electronic Transition 

Statement document to your computer from www.education.vic.gov.au/transitionstatement .  

1. Click on the Electronic Transition Statement file you want to download. 

 

Result: A pop-up will appear asking if you want to Open the file from www.education.vic.gov.au  

Select ‘Yes’ to open the file.  

 

2. When the file opens, it will open as a ‘Read Only’ file. To save the file (or download a copy), go to 

the File menu, then ‘Save As’ and select the destination on your computer where you would like 

to save your Transition Statements. This is the template you will use to complete all Transition 

Statements for children at your service, so it is recommended to use the file name ‘2017 

Electronic Transition Statement – Template’ when saving.  

 

3. Once you’ve named the file, select ‘Save’. The document will now be saved to your computer.  

 

How to create a file for the individual child’s 2017 Transition Statement 

1. Open your saved 2017 Electronic Transition Statement template. 

 

2. Go to the File menu, select ‘Save As’ and save the file as ‘2017 Transition Statement – Child’s 

name’. Use the name of the child for whom you are going to start/complete the Electronic 

Transition Statement. Each child requires their own Transition Statement.  

 

3. When you see the file name has updated to reflect ‘2017 Transition Statement – Child’s name’, 

you can begin completing the Transition Statement for that child.  

 

How to input the Child’s name into the header field 

The Electronic Transition Statement has a header that captures the Child’s name. A header appears 

at the top of each page of the document, and usually contains text or a logo (like letterhead for 

example). You only need to enter information into the header field once for it to carry through to 

each page of the document. By adding the child’s name to the header field, every page of the 

Electronic Transition Statement will display the child’s name. This means there will be no mistaking 

whose Transition Statement it is, or who the information relates to. The header field is circled below. 

In order to start using the Electronic Transition Statement once saved, go to the View menu 

and select ‘Edit document’. You will then be able to start completing the document.  

In order to start using the Electronic Transition Statement once saved, go to the View menu 

and select ‘Edit document’. You will then be able to start completing the document.  

http://www.education.vic.gov.au/
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To input the child’s name into the header: 

1. Double click over the header text (i.e. Child’s name) and you will see the header appear (a grey 

box appears ‘Header – Section 1’ with a dotted line across the page). The light grey header text 

will become darker to show the header field is now ready for editing.  

 

Result: 

 
 

 

2. The Electronic Transition Statement is protected so that only certain fields can be edited (these 

are highlighted in yellow). Move the cursor or mouse to the field (yellow box) next to ‘Child’s 

name:’ and enter the child’s name for whom you are completing the Transition Statement.  

 

Result: 
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3. Once you have entered the child’s name, double click somewhere underneath the great dotted 

line marked ‘Header – Section 1-‘ and the main body of the Transition Statement will become 

brighter and ready for you to complete.  

 

Note: The header will become dull in colour as you are no longer editing that part of the page.  

 

Result: 
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Completing Section 1: Child and Service Details 
Section 1 captures details on the child, parent/guardian, and the early childhood service. It also 

allows educators to record information on the context of the early years setting and specific 

information about the child.  

 

1. Complete all fields in Child’s Details 

Ensure Child’s year of birth is correct.  

 

2. Insert the Child’s Photo. Refer to How to insert an image for instruction.  

 

3. Complete the contact details for parent/guardian and the early childhood service.  

 

4. Follow prompts (light grey instructional text) under the headings ‘Context of early years setting’ 

and ‘Specific Information’ to complete these fields: 

 

Context of early years setting: enter a description of the ECEC service and learning environment.  

Specific Information: include information about the child and their family that may impact on 

this child’s continuity of learning (i.e. any significant health concerns, allergies, history; 

language/s spoken at home (including if appropriate Auslan, Aboriginal language); any significant 

family circumstances; specific positive learning relationships; any disclosed/diagnosed disability 

or developmental delay (more information can be provided in Section 1.2)).  

 

  

Checklist of Transition Statement components 

The final part of Section 1 is a checklist to identify which sections of this child’s Transition Statement 

are complete. The checklist outlines which sections are mandatory, and requires you to check/mark 

each checkbox as each section is completed. This not only shows you which sections of the 

Transition Statement are outstanding, but also allows the receiving teacher to know which sections 

of the Transition Statement they will be receiving for this child (i.e. if Section 1.2 has been completed 

indicating that the child requires an enhanced transition, or if Section 3: The family has been 

completed and returned).  

5. Check/mark the relevant checkboxes to indicate which sections have been completed. Refer to 

How to Check a Checkbox for instruction.  

Throughout the Electronic Transition Statement, enter required information into the marked 

yellow boxes. Use the mouse or tab key to move the cursor to each yellow box to enter a 

response.  

 

Note: The ‘specific information’ field is not intended to collect information about the child’s 

learning and development progress or strategies to support their learning, as this is collected in 

Section 1.1. 
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Note: you should only check the checkbox once you have completed each section. The first 

checkbox sits against Section 1 and Section 1.1, therefore should only be checked after both of 

these sections have been completed.  
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Completing Section 1.1 Outcomes and Teaching Strategies 

About 

Section 1.1 is the main body of the Transition Statement. This section provides both a short 

summary of the child’s learning and development, along with helpful strategies that can support the 

receiving teacher to plan curriculum, the environment and get to know what works best for this 

child’s learning style.  

For each Outcome (Identity, Community, Wellbeing, Learning, and Communication), you will need to 

provide a description of the child’s learning progress, as well a suggested intentional teaching 

strategy to support the child’s continuity of learning when they start school. Try to make these as 

specific and concise as you can, to ensure that they are easy for the receiving teacher to use to 

inform their planning. 

To make this easier, ‘pick lists’ of learning and development descriptors drawn from the VEYLDF and 

the first three levels of the Victorian Curriculum are available for you to copy/paste from. These can 

be found under ‘Outcome Descriptors’ on www.education.vic.gov.au/transitionstatement.  

Under each outcome heading you will see a number of sub-headings relating to different aspects of 

that Outcome. These sub-headings are the pick lists from which you will select learning and 

development descriptors that best describe the child’s learning progress. For example, under the 

‘IDENTITY’ Outcome there are seven pick lists (for example Attachment - engagement and 

Attachment – relationships are two pick lists that have been circle below). 

 

Each pick list contains three or more learning and development descriptors that you can select from 

to describe the child’s learning progress.  

For example, the Attachment – engagement pick list has three descriptors to choose from: 

 Is able to confidently explore and engage with familiar and new social and physical environments. 

 Is able to confidently explore and engage with familiar environments, however requires some 
support to explore and engage with new social and physical environments. 

 Requires adult support to explore and engage and develop confidence with familiar and new 
social and physical environments 

 

 

http://www.education.vic.gov.au/transitionstatement
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Actions required 

 

 

How to use the Outcome Descriptors for learning and development outcomes 

1. To view the Outcome Descriptors, hover your cursor over the name of the Outcome (i.e. 

IDENTITY). This is a hyperlink to the Outcome Descriptor list for this outcome. To select the 

link, hold down the ‘Ctrl’ key and click the outcome title (hyperlink) with your mouse.  

 
 

Result: The Outcome Descriptor list will open (in PDF format). To view the Word version of 

the Outcome Descriptors, or the full list of all Outcomes and their descriptors, go to 

www.education.vic.gov.au/transitionstatement. 

 
2. Review the list of descriptors to select between 2-5 that are relevant for this child.  

 You must select at least one descriptor for each Outcome (for example, at least one 

descriptor under ‘Identity’) 

 You can only select one descriptor per pick list (for example, one descriptor under the 

‘Attachment - engagement’ sub-heading). 

 You do not need to select a descriptor under every pick list.  

 It is recommended that you select between 2 and 5 descriptors in total for each Outcome. 

Only select those that you think are most important to communicate to the receiving 

teacher in order for them to ensure continuity of learning and development for the child. 

 

http://www.education.vic.gov.au/transitionstatement
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3. Select the outcome descriptor with your mouse so that the text is highlighted (light grey): 

  
 

4. Copy that text and paste into the relevant field back in the Electronic Transition Statement. 

Result: 

 
5. Once pasted, edit the descriptors or add additional information. For example, input the 

child’s name or other information to personalise that statement.  

 
 

How to input intentional teaching strategies 

1. For each outcome, click in the right-hand column where indicated by the yellow box to enter one 

or more intentional teaching strategies that have worked well with the child and are likely to 

support their continued learning progress when they start school. Try to keep these concise and 

specific where possible. A minimum of one intentional teaching strategy is required per 

outcome.  
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Repeat copying and pasting descriptors to reflect learning and development outcomes of the 

child and entering free text intentional teaching strategies for each of the five Outcomes 

(Identity, Community, Wellbeing, Learning and Communication). 
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Completing Section 1.2: Enhanced transitions  
Section 1.2 captures information to support enhanced transitions for a child with a disability or 

developmental delay. It includes details of early childhood professionals supporting the child and 

family, and lists reports or assessments that have been undertaken and are available to support 

early inclusion planning.  

 

1. Enter the details of specialist early childhood professional supporting this child and family 

through the transition to school. This may be an early childhood intervention professional, key 

worker, or transition support coordinator.  

 

2. Enter the details of any additional specialised professionals supporting the child. Check the 

‘Report available’ check box to indicate if there are any reports from this professional that may 

support the child’s transition and inclusion at school. See How to check a checkbox for 

instruction.  

 

3. Under ‘Additional information to support the child’s inclusion at school’, you can include more 

specific areas of note and strategies for inclusion support that relate to the child’s disability or 

developmental delay.  

 

4. Under ‘Other reports/plans available’ you can list any reports that haven’t been previously 

mentioned, the date of the report, and note whether they will be provided to the school. 

 

5. Under ‘Early ABLES reports’ you can indicate if an Early ABLES assessment has been completed 

for the child, when it was completed, and if it is available on request. If an Early ABLES report has 

been completed for the child, indicate whether the report is the first report or the second report 

by completing the relevant date field. 

 

6. Click ‘Save’ and proceed to the next section. 

 It is recommended that Section 1.2 be completed for a child with a disability or 

developmental delay.  

 A child does not have to have a diagnosis for Section 1.2 to be completed by the educator, 

but you should discuss with the parents/guardians how this section will help their child 

settle into school. 

 Section 1.2 should be completed by the ECEC educator but specialist early childhood 

professionals can contribute information (with parent/guardian permission). 

 You can skip section 1.2 (leave blank) if the child does not require an enhanced 

transition. 

Note: If there is insufficient room to capture the details of multiple specialist early childhood 

professionals engaged to support the child, these should be recorded in a separate document 

and attached to the Transition Statement when it is shared with the school or OSHC service (if 

applicable).  
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Completing Section 2: The child and Section 3: The family 
 

 

How to print the Transition Statement 

1. Ensure the details you have already entered into the Transition Statement are saved. 

 

2. Go to File and select ‘Print’. Depending on your printer you may be able to select certain printing 

options, such as double sided printing, or select the pages for printing (i.e. if you did not 

complete section 1.2, you don’t need to print those pages for the parents).  

 

3. Give a hard copy to the parent/guardian(s) and explain the significance of the Transition 

Statement and the valuable contribution they can make to sections 2 (with their child) and 

section 3.  

 

How to send the Electronic Transition Statement to the parent/guardian via email 

1. Save the Transition Statement you have been editing and then close the file.  

 

2. Open your email account and start a new email to the parents.  

 

3. Within your email, go to the ‘Attach document’ button (usually a paper clip icon).  

 

4. An attach document directory window will pop up. Navigate to where the Transition Statement 

for that child is saved and select the file to attach to the email. Click ‘Attach’ or ‘Insert’ to attach 

the file to your email. 

 

Note: This will attach an editable version of the document, meaning that parents can view (but 

also edit) any information you have put into the file. This will not override your file, as you will 

still have the original saved on your computer. It will require you to direct parents specifically to 

edit Section 2 (if you want them to complete it with the child) and Section 3, and request that 

they do not edit any other fields. 

 

Section 2 is to be completed by/for the child (by an adult the child feels comfortable with) 

Section 3 is to be completed by the parent/guardian(s) of the child, with support from the 

ECEC educator if desired. These sections can be: 

 printed out and provided to the parent/guardian(s) to complete in hard copy, along with a 

copy of Sections 1, 1.1 and 1.2 (if applicable) 

 sent via email to the parent/guardian for them to complete on computer 

If parents/guardians have any issues viewing or completing the document electronically, this 

may be due to compatibility issues (using different computer systems). In these cases, it is best 

to print out the statement and provide the family with a hard copy to complete.  
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When Sections 2 and/or 3 are completed 

 

 

If Sections 2 and/or 3 have been completed in hard copy:  

1. Scan these sections and save the PDF file to your computer. Ensure that you name the PDF file 

appropriately to ensure that you can accurately identify which child the PDF relates to.  

 

If Sections 2 and/or 3 have been completed electronically:  

1. Compare your original file with the returned document the family has provided to ensure your 

inputs in Sections 1 and 1.1 have not been edited. If your inputs haven’t been changed by the 

family, you can override your copy of this child’s transition statement with theirs, or 

alternatively you can copy and paste their answers from Sections 2 and/or 3 across to your 

original file.  

 

2. Click ‘Save’.  

If Sections 2 and/or 3 have not completed: 

1. Work with the child to complete Section 2: The child as part of their program in the early years 

setting.  

 

2. Follow up with the family to see if you are able to assist them complete this section, or obtain 

responses that are representative of the family perspective.  

 

3. Update the checkboxes in Section 1 to reflect which Sections are now complete and will be 

components of the completed Transition Statement to be passed onto the school.  

 

  

  

Remember to update the relevant checkboxes in Section 1 of the child’s Transition 

Statement to indicate which sections have been completed and will make up the Transition 

Statement. This will advise the receiving teacher of which sections of the Transition 

Statement they should have for that child.  

Remember: Section 2 and Section 3 of the Transition Statement are optional for the child and 

family to complete. Encourage completion, and if required, work together with the child and 

family to complete these sections. If they are not completed or returned, even with assistance 

offered, they will just not form part of the completed Transition Statement.  
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Completing Section 4 
1. Complete Section 4 of the Transition Statement to acknowledge that you informed the 

parent/guardian of the Transition Statement being shared, and provided them with a hard copy 

of the completed Transition Statement. See How to check a checkbox for instruction.  

 

2. If the parent/guardian has opted out of sharing the Transition Statement, check the relevant 

checkbox in the For Service Use Only line:  

 

 

 

 

Sharing the Transition Statement  
The Transition Statement can be shared either in hard copy or electronically. It is important to 

remember that it is only shared with the family, who receive a completed copy of the statement in 

their preferred format (hard copy or electronic), and with the receiving school or OSHC service if the 

parent/guardian has NOT opted out of the Transition Statement being shared.  

 

How to print the Transition Statement 

1. Ensure the details you have already entered into the Transition Statement are saved. 

 

2. Go to File menu and select Print. Depending on your printer you may be able to select certain 

printing options, such as double sided printing, or select the pages for printing (i.e. if you did not 

complete section 1.2, you don’t need to print those pages).  

 

3. Provide a hard copy to the parent/guardian(s).  

 

4. Assuming the parent/guardian has not opted out of sharing the statement with the receiving 

school, provide a hard copy to the receiving school and to the OSHC service (if applicable).  

 

If the parent/guardian opts out of sharing the Transition Statement, this means that you:  

 are not able to provide it the Transition Statement to the school or OSHC service  

 must provide a copy of the Transition Statement to the parent/guardian only.  

It is then the parent/guardian responsibility to share it with the school if they choose to.   

Important note on privacy: Educators completing Transition Statements, regardless of the 

format they are using, are required to adhere with all privacy laws regarding the collection 

and disclosure of personal and health information, which includes the Transition Statement. 

Refer to Privacy and information sharing  for further information.  

http://www.education.vic.gov.au/childhood/professionals/learning/Pages/transkitprivacy.aspx
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How to create a PDF version of the Electronic Transition Statement 

  

To create a PDF: 

1. Go to File menu and select Save As, and select a location to save your PDF Transition Statement. 

It would make sense to save it in the same location as the Word version for this child.  

 

2. When the Save As window pops up, select the location for saving, check that the file name is the 

same as your Word version. In the ‘Save As Type’ field (below the file name) use the right hand 

arrow to dropdown the list. 

 

3. Select PDF from the ‘Save As Type’ drop down list: 

 
 

4. Select Save.  

Note: When you hit ‘Save’, your computer will create the PDF of the Transition Statement. 

Depending on your computer settings, the PDF will usually open automatically, so you can see 

that all of the information is there and displaying correctly. If you notice that something is 

wrong, you will still have your Word version open, or saved, that you can amend before creating 

the PDF again.  

Once the Electronic Transition Statement is complete, it is recommended to save the file as 

a PDF prior to sending via email. This will ensure no further changes can be made to the 

finalised Transition Statement, and makes it easier for those receiving it to navigate the 

document.   
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How to send the Electronic Transition Statement via email 

1. Password protect the Transition Statement you have been editing and then close the file.  

 

2. Open your email account and start a new email to the parents or school.  

 

3. Within your email, go to the ‘Attach document’ button (usually a paper clip icon).  

 

4. An attach document directory window will pop up. Navigate to where the Transition Statement 

for that child is saved and select the file to attach to the email. Click ‘Attach’ or ‘Insert’ to attach 

the file to your email. 

 

 

Troubleshooting 

Can I exit the Electronic Transition Statement without finishing it? 

Yes, you can exit the Electronic Transition Statement without finishing it at any time, and if you have 

made any changes then Microsoft Word should remind you to save the file prior to exiting/closing 

the file. Select the ‘Save’ button if you do not want to lose any changes you have made.  

How do I go back into a Transition Statement that I have already started or completed? 

Open the file from where you saved it on your computer.  

Why can’t I edit the whole Electronic Transition Statement? 

The Electronic Transition Statement has restricted editing permissions on it, so that users don’t 

accidentally change the key information (titles and instructions) in the form. Anything that is marked 

in a yellow box can be edited either by directly typing into the box, by copying and pasting text into 

the box, or by selecting an option from the icon already there (i.e. check box, date or the drop-down 

picklist).  

Where else can I get help? 

Refer to the Handy How-to Instructions for guidance on the functionality of this document. Refer to 

the Tips for assistance on how to save, undo, copy and paste into your document. Microsoft Word 

itself has a Help function that might be useful to you, otherwise further IT support is available 

through State Library Victoria (details below).  

 

 

 

 

   

Further IT support is available via State Library Victoria:   

Phone: 03 8664 7001       Toll Free: 1800 629 835      support@kindergarten.vic.gov.au 
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Handy How-to Instructions  
The Electronic Transition Statement includes some new functionality to streamline the form and 

make it easier for users. The following ‘How to’ guides will assist you in familiarising yourself with 

common functions of the Electronic Transition Statement: 

 How to insert an image or photo 

 How to check a checkbox 

How to insert an image or photo to the Transition Statement 

Note: In order to insert an image to the Transition Statement, it will need to be saved as an 

electronic file in your system.  

1. To insert an image, click into the yellow box in the centre of the field where you want the image 

to be so the cursor appears there: 

 
 

2. Go to the menu bar at the top of the page and select ‘Insert’ then ‘Pictures’: 
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Result: The ‘Insert Picture’ window will appear so you can select the image/photo from where it 

is saved on your computer: 

 

 
 

3. Locate the image/photo on your computer, select it by clicking on it once and then click on the 

‘Insert’ button (as marked below). Note: when you select the image, the file name will 

automatically populate into the File name field at the bottom of the window.  

 
 

Result: Your image/photo will be inserted into the Transition Statement form.  
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Note: An alternate method of inserting an image is to ‘cut’ of ‘copy’ the image from somewhere else 

and ‘paste’ it into the box.  

4. To reduce, enlarge or rotate your image, click once on it (to select) and use the corner dot 

(circled below) to adjust the size, or the circled arrow at the top of the image to rotate it.  Small 

arrows will appear when you use the dots to adjust the size.  

Result: 

 

Note: Depending on the size of the image selected, it may be pushed onto a new page. Resize the 

image using the corner dots (circled above) to reduce its size so that it fits into the designated space.  
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How to check a checkbox 

Throughout the Electronic Transition Statement there are a number of checkboxes that require your 

response. These are indicators to yes/no questions, or to acknowledge that certain actions have 

been taken (such as Sections completed, or parents informed).  

To check a checkbox: 

1. Double click in the centre of the checkbox square: 

 

Result: This will bring up a ‘Check Box Form Field Options’ window. You will see that the default 

value of the checkbox is ‘Not checked’.  

2. Select the button next to ‘Checked’ to mark the checkbox.  

        
 

Result: Your checkbox will now be ‘Checked’, showing a cross mark in the checkbox. 
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Note: To ‘uncheck’ the checkbox, follow the same process as above, but change the Default value 

from ‘Checked’ to ‘Not checked’  
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Tips 

Tip 1 – Save often 

It’s a good idea to save often as you are writing your Transition Statements. This is particularly 
helpful when you are completing Section 1.1 where you are selecting and editing learning and 
development descriptors, and writing intentional teaching strategies. 
 
The ‘Save’ button is located under the File menu, but there are also two shortcuts you can use: 

 

    OR    

 

Tip 2 – Remember you can Undo 

If you want to undo something that you’ve just done in your document (before you hit save) you can 

select the undo arrow from the top menu, or press the ‘Ctrl’ and the ‘Z’ key simultaneously.  

     OR     

 

Tip 3 – You can copy/paste content into text fields 

If you want to copy some existing text into your Transition Document, you can do so into the yellow 

boxes that outline where you have permission to enter text.  

To copy text: 

1. Select the text you want to copy with your mouse or cursor, so that it is highlighted light grey: 

 
2. Once selected, right click and select ‘Copy’, or hit Ctrl C on your keyboard.  

To paste text: 

1. Move the cursor to where you want to paste the text. In the Electronic Transition Statement this 

will be a yellow box.  

2. Click inside the yellow box and then right click and select ‘Paste’, or hit Ctrl V on your keyboard.  

Tip 4 - You can password protect a Word file in Microsoft Word 

1. Click the ‘Office’ or ‘File’ button in the top left hand corner of the screen. 
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2. Select ‘Prepare’ 
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3. Select ‘Encrypt Document’ 

 

1. Enter your chosen Password. It is recommended to use a password that you and the recipient 
will know or understand. 

 

Document is now password protected. 
 
To complete the process: 

 Send the password you have set to the recipient in an email for the purpose of opening the 
document 

 Attach the Electronic Transition Statement to a separate email 

 Send the Electronic Transition Statement to the recipient - do not include the password in 
this email. 

 


